
A Hot Zone Button.
The Button Wizard consists of two pages: Command and Size.

The Command Page:

This page is the same as the other two. Just specify the application to start and select "Hot Zone."

The Size Page:

"Height" and Width" refer to the size of the Hot Zone in pixels.    Once you have specified the height and width, click 
Finish. Nothing will appear on the Theme, but if you move your cursor around you will eventually find the Hot Zone. 
When you switch to Work Mode, clicking on the Hot Zone will start the application.
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A Picture Button.
The Button Wizard consists of three pages: Command, Picture and Text.

The Command Page:

This page is used to select the application to be started by the button and the kind of button.
Start by identifying the application you want that button to start. You can either type in the path (for example, c:\
program files\microsoft office\office\excel.exe) or use the folder at the right to browse to that location. If you want 
the button to open a My Computer window to a drive or folder, key in "explorer [drive letter]\:[folder name]" without
the quotes and substituting the drive letter and folder name for the bracketed items; for example, explorer c:\
mydoc. 
See Command menu for a description of the popup menu commands. 
See Internal Commands for a description of all available commands. 
See Scripting for a a description of the Talisman's script system.
Next, select "Button."
Click "Next"

The Picture Page:

This page is used to assign pictures to the button. A button may have three different faces: the UP face (the Main 
Picture and what you see normally), the HIGHLIGHT face (the Second Picture and what you see when the cursor 
moves over the button, and the DOWN face (the Third Picture and what you see when the cursor is clicked on the 
button). By default, Talisman uses the application's icon for all three pictures. Pictures in the bmp, jpg and jpeg 
formats may also be used.
If you have other graphics that you want to use you can. Uncheck the "Use file icon" box and click on the folder to 
browse to your picture's location and select it.
If you want to delete a picture, click on the button marked "X."
If you selected Microsoft's Excel as the application on the Command Page of the Wizard, Excel's icon should appear 
in all three Picture windows.
You can move the application's icon to a new position on theme by dragging (see below Locations and Moving 
Buttons).

Load button list displays all available BTN3 templates in theme folder and in ../talisman/buttons folder. BTN3 file is a
BMP-file with three phases of button: normal, highlighted, pressed.

The Text Page:

This page is used to define a name for the button. The page has two parts. The part on the left shows the button 
picture and the name you may give it. On the right are the controls for setting up the name.
If Excel was the application selected, the executable will be spelled out in the Textstring box; for example, 
excel.exe. By default, Talisman uses the MS Sans Serif font, 8 point regular, light blue. If you want to change the 
name or delete the extension, make the change in the Textstring box. If you do not want to name the button, delete
the Textstring.
If you want to change the font, use the Change Font button, the button to the right of the font with the three dots in
it.. This brings up the standard Windows font dialog box. If you want to use other than the Talisman default font, 
change the font and size in the Windows font dialog box.
You can change the font's display color by clicking on the Text color button. This brings up the standard Windows 
color picker. For the use of the other color, see Color and Transparency.
You can move the textstring to a new position on your future button by dragging (see Locations and Moving 
Buttons).
The button will appear on the Theme. Switching to Work Mode will activate the button.
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A Text String Button.
The Button Wizard consists of two pages: Command and Text.

The Command Page:

This page is used to select the application to be started by the button and the kind of button.
Start by identifying the application you want that button to start. You can either type in the path (for example, c:\
program files\microsoft office\office\excel.exe) or use the folder at the right to browse to that location. If you want 
the button to open a My Computer window to a drive or folder, key in "explorer [drive letter]\:[folder name]" without
the quotes and substituting the drive letter and folder name for the bracketed items; for example, explorer c:\
mydoc. There are also internal commands in the drop down list and, if there are additional forms in the Theme, Go 
to Form X (where "X" stands for the form number). "Moved" and "Closeforms" are covered below in the section 
Forms.
Next, select "Text String."
Click "Next"

The Text Page:

This page is used to define a name for the button. The page has two parts. The part on the left shows the button 
text string. On the right are the controls for setting up the name.
If Excel was the application selected, the executable will be spelled out in the Textstring box; for example, 
excel.exe. By default, Talisman uses the MS Sans Serif font, 8 point regular, light blue for the UP color and a 
HIGHLIGHT color of yellow. If you want to change the name or delete the extension, make the change in the 
Textstring box.
If you want to change the font, use the Change Font button. This brings up the standard Windows font dialog box. 
Change the font and size in the Windows font dialog box.
You can change the font's UP color by clicking on the Text color button and the HIGHLIGHT color by clicking on the 
Color button. Both buttons bring up the standard Windows color picker.
You can move the text label in a new position on your future button by dragging (see Locations and Moving 
Buttons).
Click Finish. Your Text Button will appear on the Theme. Switching to Work Mode will activate the button.
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About
Talisman is a product of Lighttek Software.

Author (Idea, design, programming)                            Arkadiy Istomin
Programming                                                                                                  Arkadiy Istomin, Andy Chentsov, Sergey Kachalov
English text of this help file                                                        Bill Hobson

If you have access to the Internet, be sure to visit Talisman homepage. You can download the latest versions and 
updates of Talisman as well as some other cool programs and themes for Talisman.
URL:      http://www.lighttek.com

E-mail address for information, feedback, suggestions, bug reports, support etc:
support@lighttek.com



Adding Buttons
Right click in an empty space in the Talisman Window and switch to the Edit Mode. A new menu appears. Select 
“New,” then "Button." When you select "Button," the Button Wizard appears. The Wizard consists of different pages 
depending on what type of button you select.

A Picture Button
A Text String Button
A Hot Zone Button
Locations and Moving Buttons
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Adding Forms
Before adding forms, you should review the section Forms .
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Adding HTML pages
HTML page object works only on computers with installed MS Internet Explorer 3.x, 4.x, 5.x .

The commands for HTML-objects:

htmlback object_name
htmlforward object_name
htmlhome object_name
htmlrefresh object_name
htmlstop object_name
htmlurl object_name <URL>

When an HTML page object is created, Talisman assigns a name to it. For example, an HTML page created on form0 
as the third object is assigned the name html0_3 (the name can be changed in the Editor). Thus in the command 
htmlback object_name, the “object_name” would be html0_3; the full command would be htmlback htm0_3. New 
buttons can be created for each of the commands.

The HTML page can display Web pages, file directories, or files that have an assigned association. Examples of the 
commands are:

To display
1. A web page automatically in the HTML Page: Use the URL as the Filename in the HTML pages’ properties; for 
example, http://www.lightek.com
2. A local file automatically in the HTML Page: Use “file:///[path]” (without the quotes); for example, file:///c:\
talisman\readme.txt
3. A local directory automatically in the HTML Page: use “file:///[path]” (without the quotes); for example, 
file:///c:\talisman

To create a button to display
1. A web page in the HTML Page: use “htmlurl object_name url” (without the quotes); for example, htmlurl 
html0_3 http://www.lighttek.com/themes
A local file in the HTML Page: use “htmlurl object_name path” (without the quotes); for example, htmlurl html0_3 
file:///c:\talisman\readme.txt

If you have installed Flash4 plugin for IE, VRML plugin for IE, MS Office 97/2000 or other OLE compatible 
applications, you can use the documents of this programs as your HTML objects in Talisman.
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Adding Pictures.
One of the really nice things about Talisman is that you can decorate your Theme with pictures - pictures of your 
family, vacation, of something special like a motorcycle, or of a work of art. The only limits to the number of 
pictures you can display are the sizes of the pictures and the amount of screen real estate you have.
When "Picture" is selected, Talisman opens the standard Windows Open dialog box. Browse to the picture's location 
and select it. After you click on "Open," the dialog box will close and picture will appear on the Theme. Pictures may
be in bmp, jpg or jpeg format.
Pictures are initially placed on the screen at the location where you right clicked. Pictures can be moved just like 
buttons.
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Adding Shapes
Shape is a rectangle with any solid color or tiled picture without any command. It eliminates the need to create 
rectangular color blocks in an outside graphics editor and add them as pictures. You can change sizes, position, 
color, border size, picture background and transparency of Shape in the Object Editor.
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Adding Text Blocks.
Text Blocks are decorative objects. A Text Block is a block of text. Talisman will handle a block up to 64K in size. A 
Text Block can be used for things like reminder lists, quotations or excerpts from a book. Creating a Text Block is a 
three step process: creation, completion, and position.

Creating a Text Block.

In Edit Mode, right mouse click on the Theme to bring up the pop-up menu, then select New>Text block. When you 
release the mouse button, "New text block. Click here to edit." will appear on the Theme. Left clicking on those 
words will open the text block for editing and a scroll bar will appear at the right. When a text block is created, 
Talisman assigns a size for the display of the text block of 200 pixels wide by 100 pixels high. This size can be 
changed, but only in the Talisman Editor.

Completion of the Text Block.

Text can be keyed in directly to the text block. Text can also be copied and pasted using right mouse clicks or 
standard keyboard commands (Ctrl+c for copy and Ctrl+v for paste). When you are finished editing, click outside 
the Text Block. Text Blocks cannot be edited or scrolled in Work Mode

Position of the Text Block.

Text Blocks are initially placed on the screen at the location where you right clicked. They can be moved just like 
buttons and pictures.

Some Comments on Formatting Text.

The Text Block does not support tabs or word wrap. Indents or centering must be accomplished with spaces. The 
Enter Key must be pressed at the end of each line; if it is not, the text will continue to flow to the right until the 
Enter Key is pressed. 
Resizing of the Text Block is available only in Talisman Editor .
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Adding new objects
Talisman has been designed so that almost all editing can be performed without ever using the Talisman Editor. 
Using the right mouse click in the Edit Mode, the main picture can be changed, the color of certain objects can be 
changed, and objects - buttons, pictures, shapes, text blocks, and forms - can be changed or added to the Theme.
As mentioned earlier, objects are either interactive or decorative. Interactive objects are buttons that start an 
application. Buttons can be pictures, text strings or a hot zone. A picture button can be the application's icon or 
some other picture (formats: bmp, jpg or jpeg) that you would prefer to use, like one you have designed yourself. A 
text string button is a word or phrase describing the application. A hot zone button is an area of Theme that when 
clicked on, starts an application; the zone itself is invisible.

Adding Buttons
Adding Pictures
Adding Text Blocks
Adding Shapes
Adding Forms
Adding HTML pages
Display sequence
Internal commands
Scripting
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BLOB has been modified.

Question: I have downloaded Talisman and I think it is great! But, I have a problem! When I change things in a 
theme and then restart, I get an error-message that says: BLOB has been modified. Sometimes I get an error-
message that says: Bitmap is not valid. It happens when I try to change AfterStep, Enlightenment and BeOs 
themes! Please help me!

Answer: It is an error in the database in one of the graphic fields. You can either delete the button or picture that
has the error or replace the corrupted graphic in ObjectEditor. The main difficulty is finding this corrupted field. Most
likely it is one of the last changed buttons. Another and cardinal way is to replace all database files runic.* with new.
You can also use the "Ctrl+P" (pack database) key command. The theme will be packed and corrupted graphic will 
be deleted.



Color and Transparency.
Every object has a colored background. Consider what happens when you open a graphics editor and create a new 
file. When the window for that new file is opened, there will be a base or background color. You then create your 
graphic on top of that background color. If the graphic completely fills the window, the background color effectively 
disappears. If, however, you use only a part of the window, what you do not use is taken up with the background 
color. When that graphic is brought into Talisman, the background color is brought along.
Talisman treats text blocks and application icons used as buttons    as having transparent backgrounds. For all other 
objects, Talisman treats their backgrounds as solid.
When "Color" appears in an object change pop-up menu, it means the background color. For all intents and 
purposes, when an object (remember, not a text block or an application icon used as a button) is brought into a 
Talisman Theme, Talisman ignores the individual colors in the object and simply treats it as a solid object. The 
change color command allows you to select a specific color, then have Talisman treat that color, where ever it 
appears in the object, as transparent, semitransparent or solid.
An example. Your Talisman Theme has a green background. You have used a TextString button to start Excel, and 
you have use a small right arrow to indicate that the button does something. The arrow is blue on a black 
background. On the green Theme background, what you see is a 20x20 object - black with a blue arrow. You want to
get rid of the black. To do that you would first select the black color using the pop-up menu and the Windows color 
picker, then select "Transparent." The black background will disappear and just the blue arrow will remain.
Text blocks are a little different. By default, text blocks are transparent. If you change the color without changing 
the transparency, the new color will appear as the background color only when you click on the text block. If you 
change the color and the transparency to either semitransparent or solid, the new color will become the visible 
background of the text block.



Filename: Opens the standard Windows Open Dialog which you can use to navigate to the location and application
you want to execute. 

Folders: Opens specific Windows folders in Windows Explorer and contains options: 
desktop: opens the Desktop Folder. 
documents: opens the Recently Opened Documents Folder. 
programs: opens the Programs Folder. 
mycomputer: opens the My Computer Folder. 
controlpanel: opens the Control Panel Folder. 
dialup: opens the Dialup Networking Folder. 
recycle: opens the Recycle Bin Folder. 
network: opens the Network Folder. 
mydocs: opens the My Documents Folder. 
fonts: opens the Fonts Folder. 
printers: opens the Printers Folder. 

Theme: has two options: 
open: opens the Folder for the current Theme. 
home: changes the current Theme to the default one. 

Forms: has five options in two groups: 
go to form: opens a submenu listing the forms included in the Theme. See Adding Objects, Forms, Creating 

the Button for additional information on the difference between "go to form" and "popup form.". 
popup form: opens a submenu listing the forms included in the Theme. See Adding Objects, Forms, Creating 

the Button for additional information on the difference between "go to form" and "popup form.". 
refresh: refreshes the form on which the button is placed. 
closeform: for forms other than form0,closes the currently visible form and returns the Theme to form0. 
moved: used to move a less than full screen from from one screen position to another. 

Menu: has 11 options in three groups: 
foldermenu: creates a popup of the the contents of a specific folder. The syntax is 

foldermenu [drive]:\[folder]. 

For example, if Microsoft Office is on the f:\ drive, the command would be foldermenu f:\microsoft office      
You can add additional folder statements ([drive]:\[folder]\[folder]\[folder]…). 

By default, the popup menu appears in the middle of the button. The location of the popup menu relative to the 
button can be controlled by the switches menubottom, menutop, menuleft, and menuright. If you want the popup 
menu to start at the left of the button in the example, the syntax would be

foldermenu f:\microsoft office menuleft.

Foldermenu can also be used to open a Talisman theme if you select the runic.db file; for example,

foldermenu c:\talisman\themes\default\runic.db

startmenu: creates a popup of the Windows Start Menu. 
taskmenu: creates a popup of the currently open applications. 
control panel menu: creates a popup of the Control Panel applications. 
desktop menu: creates a popup of the contents of the Desktop Folder. 
quicklaunch menu: creates a popup of the quicklaunch panel path from the registry. 
documents menu: creates a popup of the Recently Opened Documents Folder. 
programs menu: creates a popup of the Programs Folder. 
favorites menu: creates a popup of the Windows Favorites Folder. 
my documents menu: creates a popup of the contents of the My Documents Folder. 
fonts menu: creates a popup of the Windows Fonts Folder. 
local menu from file: creates a popup based on the contents of a *.mnu file. See Adding Objects, Scripting for

additional information about *.mnu files. 



HTML Commands: has six options. In the following command descriptions, the term object_name refers to the 
name given the HTML Page object when it was created; an HTML Page object created on form0 as the third object is
assigned the name html0_3 (the name can be changed in the Editor). 

htmlback object_name: performs the same function as the back button on a web browser; syntax example 
assuming the object_name is html0_3: htmlback html0_3. 

htmlforward object_name: performs the same function as the forward button on a web browser.; syntax 
example assuming the object_name is html0_3: htmlforward html0_3. 

htmlhome object_name: performs the same function as the home button on a web browser.; syntax example
assuming the object_name is html0_3: htmlhome html0_3. 

htmlstop object_name: performs the same function as the stop button on a web browser.; syntax example 
assuming the object_name is html0_3: htmlstop html0_3. 

htmlrefresh object_name: performs the same function as the refresh button on a web browser.; syntax 
example assuming the object_name is html0_3: htmlrefresh html0_3. 

htmlurl object_name <URL>: there is no exact browser counterpart for this command. It is used to create a 
button that directs a web page, local file or directory to open in the HTML window. 

Some syntax examples to create a button to display: 
A web page in the HTML Page object: use htmlurl object_name url; for example, htmlurl html0_3 
http://www.lighttek.com/themes
A local file in the HTML Page object: use htmlurl object_name path; for example, htmlurl html0_3 file:///c:\
talisman\readme.txt.
A local directory in the HTML Page objct: use htmlurl object_name file:///[path]; for example, htmlurl html0_3 
file:///c:\talisman

Misc: has 12 options: 
minimize: minimizes the Talisman window; not available in shell mode. 
shutdown: shuts down Windows. 
logoff: Log Off.
quit: quits Talisman; not available in shell mode. 
about: gives information about the program and how to register to use it. 
run: opens the Windows Run Dialog box. 
findfile: opens the Find Files dialog. 
wavplay: plays a *.wav file; requires a path statement to the file. See Adding Objects, Scripting for additional 

information. 
pause: creates a pause in a script or command series execution; "pause" increments are in tenths of a second.

See Adding Objects, Scripting for additional information about using "pause." 
write: changes a database element. This command is very dangerous and should be used with extreme 

caution. See Adding Objects, Scripting for additional information. 
draw: draws a picture on the same form on which the button is at a specific top left position. See Adding 

Objects, Scripting for additional information. 
drawframes: draws an animation. See Adding Objects, Scripting for additional information. 
connect <Connection Name>    Dialup connection.



Introduction
Talisman is a desktop alternative for Windows 95/98/ME/NT/2000. Using "Talisman", you can build any 
interface for your computer. "Talisman" hides the standard desktop of Windows. In the "Talisman" 
workspace, you can place any number of buttons or pictures. These objects can have any form or 
dimensions. All objects can run external programs or internal shell commands. The number of forms 
(screens) can range from 1 to 1000. Any screen object can be set to switch from one form to another. All 
settings and pictures are stored in a database file. You can even make many Talisman-themes and use 
objects with links to go from one theme to another.
You can use Talisman as your default shell instead the Windows Explorer. Talisman has the own startup, 
tray, taskbar and startmenu procedures.

Features
Using Talisman as a Shell

Window and Menus
Adding Objects
Making changes
Themes
Object Editor
Sounds in Talisman

Internal commands
Scripting

Frequently Asked Questions
Registration
About
 



Themes

Creating your Themes

Example of Talisman theme:

      

You can work with the startup Theme, download other themes from the Talisman site 
http://www.lighttek.com/themes, or create your own. 
If you want to create your own, there are two ways to go about it. You could use the startup Theme, delete all the 
objects, then start over. The easier way is to go to the Edit Mode>Theme>New. When selected, a popup dialog asks
for the name of the new Theme, creates a folder for it in the Themes subdirectory, and creates a new Runic.db and 
related files in the folder. 

Theme.INI

Talisman uses a theme.ini file to control configuration of a theme's various interface elements. When Talisman is 
installed, it creates a theme.ini file in its root directory. As new Themes are created and opened, Talisman creates a 
theme.ini file in the new theme's subdirectory. The following reproduces the theme.ini file from the Talisman root 
directory and explains the various elements:

Using a Downloaded Theme

Many Themes are available for downloading from the World Wide Web at such sites as http://www.lighttek.com/themes, 
http://skinz.org. Using a downloaded theme presents two major difficulties. First, the path statements for application
will have to be changed. Second, the Theme may have been developed for a screen size that is different from the 
one you are using. 

Uploading a Theme



We are always on the lookout for new Talisman Themes. We encourage new and experienced Talisman users to 
make their themes available to the Talisman user community. The Talisman Theme repository is located at 
www.skinz.org in the Talisman Section.

In order to upload a theme to    www.skinz.org, you will need to establish an account (it’s free). Then follow the 
instructions for uploading. We recommend that you 

1) For large background pictures use the 256 color bmp-files or JPEG-files. Be sure to include the picture in the zip file and that the 
theme includes the correct path.
2) If the second and third pictures for graphic buttons are the same as picture one, delete the second and third pictures.
3) If your theme has the object "Picture from file", please, check the filename of this pictures in Object Editor. Filename should not 
have a local path string from your computer. For example: 
correct filename: picture.jpg
wrong filename: f:\programs\talisman\themes\mynewtheme\picture.jpg
4) Make fullscreen JPEG screenshot for skinz.org (not GIF as they wrote!)
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Display Sequence.
Talisman uses a specific sequence to display objects on the Theme. Talisman displays objects in the order in which 
you created them. For example, if you create two objects of the same size each on top of the previous, Talisman will
only display the last object created. You can, however, change the display sequence through the pop-up menu. Use 
the sub-commands "Send to back" or "Bring to front." 
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E-Mail Addresses for Registered Users

Question: I have registered Talisman, but have not gotten back my registration key.

Answer: Sometimes the e-mail address is incorrectly entered in the registration form and the e-mail with the key
is bounced back as undeliverable. If you haven't received your key in seven days, contact Lighttek from you primary
e-mail address
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Editing a Parent Form's Properties - Basic

Primary Parent or Base Form.

Four things can be changed: the background color, the background image, the location and size. The background 
color is changed through the Object>Color command. The background image may only be changed in the Editor. 
The location and size are changed through the Theme>Resize/Move command. Autohide and semitransparent do 
not have any effect on the Base Form.

Secondary Parent.

Since a secondary parent is the same size as the primary, its size and location would not change, but its color or 
background image may. Use Object>Color to change the background color. The background image may only be 
changed in the Editor. The Object>Autohide and Theme>Resize/Move command do not have any effect

Editing a Child Form's Properties - Basic
Changing the Form's Size.

When a form is created using the pop-up menu in Edit Mode, Talisman creates a new form the same size as the 
primary parent. If you want to use the new form as a child on either the primary parent or on a secondary parent 
and do not want the form to be "full size," you will have to change the form's size. The form's size may only be 
changed in the Talisman Editor. In Edit Mode, select Object>Editor. This opens the Talisman Editor. Find the fields 
labeled "Width" and "Height." Change these numbers to the size you want. The numbers are in pixels.
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Editor Control Buttons

Close: closes the Editor window and writes changes to the database;
Redraw: redraws the screen;
Restore: restores an object’s characteristics to what they were before changes were made and may be used only 
immediately after the changes, but before another object is selected;
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Object Information Window.

The Object Information Window contains all the information about the selected object when it was created or after it
has been edited. The information about each object may be edited in this window. Across the top of the window is a 
title bar. It contains a description of the object (button, picture, etc.), its number or name and two buttons: “Ren” 
and “Del.” “Ren” is used to rename the object. “Del” is used to delete the object.

Theme Window 
Main Menu Window 
Form Window 
Button Window 
Picture Window 
Shape Window 
HTML Object Window 
Text Block Window 
Inputbox Window
Taskbar Window
System tray Window
Clock Window
Script Window
Menu Window
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Features 

· Creating multilevel user defined desktops 
· Use of any number of pictures of any type or dimension, instead of standard icons. 
· Place, free-moving and imposing of objects in the Talisman workspace. 
· All objects can run external programs or internal shell commands by one click of the mouse. 
· The number of forms (screens) in one theme can range from 1 to 1000. Any screen object can be set to switch 
from one form to another. 
· You can create a set of independent themes, and store them on any disk in the local computer or on a local area 
network.
· You can easily switch between different themes through your own objects or through the Talisman menu. 
· The Built-in Object Editor allows the creation, modification and removal of any element in a theme. 
· Large number of basic elements (forms, pictures, buttons of different types,text blocks) 
· Customizable system tray, taskbar and clock. 
· Sound support for all events. 
· Applications, Task, Theme, Foldermenu, Run, Find, Desktop, ControlPanel, Network, Dialup, Documents and other 
internal commands.
· Script language.
· Customizable menus.
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Forms
As Object Containers

As we have mentioned before, a Theme is a collection of forms and objects. A Theme must have one form. If a 
Theme has more than one form, each additional form serves as a container for additional objects: buttons, pictures,
text blocks.

What Are They Good For - When To Use

The purpose of Talisman is to provide a desktop that is attractive and functional. It is easy to make the main form 
attractive: add a couple pictures and tile the background image using a pleasing texture. Almost as soon as you 
start adding buttons, though, attractiveness begins to diminish.
Except for the main form, all other forms are hidden until they are invoked. Thus, using additional forms gives you 
the opportunity to populate your Theme with as many buttons, pictures and textblocks as you want, but keep them 
hidden until you need them. Forms are also a means of organizing your buttons. For example, you might have a 
form containing buttons for basic productivity applications, another form for graphics applications and a third form 
for games.

Creating a Form

In the Edit Mode, select New>Form. Talisman creates a new form. It assigns it the next number in the form 
sequence, colors it blue, and makes it the same size as the Base Form. It also adds a textstring button "This is 
formX. Press here to back in main form," where "X" stands for the form number. Talisman can contain up to 1000 
forms (parent form 0 through parent form 999). The parent form 0 (zero) is reserved for the primary parent form, 
the Base Form.

Invoking a Form

Just an application can be started using a button, a button is used to invoke a form. Before creating a button to 
invoke the form, you must first create the form, then create the button to invoke the form.
Creating the button, however, is complicated by how you want the button to invoke the form: by rollover or by click.
A form invoked by a rollover button will be a popup form and, if the form hides the button, the form can be edited in
the Editor to autohide when the cursor moves off the form.

Creating the Button

Create a button to invoke the form just like you would any other button. In the Edit Mode, select New>Button. In the
command box, select "go to form XXX," where "XXX" is the form number (form9 would be shown as "009"). 
Selecting “popup form XXX” will create a form that pops-up when the cursor moves over the button and, , if the 
form hides the button, the form can be edited in the Editor to autohide when the cursor moves off the form. Select 
the button type. If you select picture, you will have to have your own graphic for the picture (some sample button 
graphics are available at the Talisman site (http://www.lighttek.com/themes ). Rollover buttons may use all three 
button states, but usually only the normal or UP state is necessary (actually, this depends on whether the button is 
hidden by the form or not; if it is not hidden the HIGHLIGHT state can be used and will remain visible as long as the 
form itself in visible). Click buttons may use all three button states. 

Types of Forms

The next logical step would be to start populating the new form with objects. But it's not. There are a few things you
need to consider before you begin: where you want the form to appear, what type of form it should be and what its 
size and position will be.



Parent and Child Forms.

Technically, the main form, the one you see when a Theme starts, is the parent form, and all other forms are its 
children. As you will see in a moment, it might be simpler, however, to discuss forms as primary parent, secondary 
parent, and child. 
The primary parent form is form 0, the Base Form for the Theme and the one that appears when Talisman is started.
A secondary parent form is a form the same size as the primary, but underneath, hidden by, the primary. A child 
form is a form layered on top of either the primary parent form or a secondary parent form.
A base with a just a primary parent is like a sheet of paper. A base with a primary parent and one or more 
secondary parents is like a stack of papers, with the primary parent as the top sheet in the stack. A child form is like
a 3M Post-It Note stuck on one of the sheets of paper.

Editing the Form
Moving the Form
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Frequently Asked Questions
Using Sound in a Theme
BLOB has been modified
Using Talisman as a Shell
E-Mail Addresses for Registered Users
Talisman do not start in shell mode and Windows say: 'I must be reinstalled'
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Icon Extraction

While Talisman has built-in icon extraction, one sometimes wants to use icons other than the application's built in 
default icon. Icons come built into the *.exe, as part of *.dll files, or as *.ico. Most graphics editors do not open these
files and permit saving them in a format other than their original one. We recomend to use the IconTOY for working 
with icons.

IconToy From Lighttek Software, it extracts icons from *.exe, *.dll, *.cpl, *.icl, *.ocx, *.scr and *.ico files; it also 
displays *.bmp. It will save the selected icons as *.ico (16color, 256color, High Color, True Color) or *.bmp or copy 
icon in clipboard (then you can paste it in Button Wizard or Object Editor). It can also be used to assign desktop 
wallpaper, either centered or tiled. Once the file extension is defined, it extracts the icons from all files of that type 
on the selected harddrive or partition.

http://www.lighttek.com



TOE: The InputBox Window
Top: The measurement in pixels from the top of the parent form. A top coordinate of 0 (zero) would place the child 
form at the top edge of the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of
the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside 
the visible desktop or Talisman window.

Left: The measurement in pixels from the left edge of the parent form. A left coordinate of 0 (zero) would place the 
child form at the left edge of the parent form, while a coordinate of 15 would place it 15 pixels in from the left edge 
of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is 
outside the visible desktop or Talisman window.

Height: The height of the object in pixels. 

Width: The width of the object in pixels.

Background color: Shows the color of the background for the inputbox.

Font: The font, size, style and color used in displaying the inputbox.

Command: The attached command for inputbox.    "Run" will start the entered to inputbox command immediately. 
"Enter URL" will transfer the entered to inputbox command to any HTML object.
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Internal Commands
See also:    Special commands    and    Scripting

You can enter multiple commands in the button command string or in the theme autostart command string    with ";"
as a separator. Or you can create a    *.tscr file - a text file with one command on each line. 

Commands:

startmenu <parameters> - show startmenu;
controlmenu <parameters> - show control panel as popup menu;
taskmenu <parameters> - show taskmenu;
foldermenu        <path> <parameters> - open any folder as popup menu;

path equivalents:
                                            programs  - programs folder;
                                            desktop    - desktop folder;
                                            documents    - documents folder;
                                            favorites    - IE favorites list
                                            strt    - startmenu    folder;
                                            quicklaunch    - Windows quicklaunch panel items;
                                            mydoc    - My Documents    folder;
                                                          fonts    - Fonts folder;
parameters:
                                            menutop    - show popup menu from top side of button;
                                            menubottom    - show popup menu from bottom side of button;
                                            menuright    - show popup menu from right side of button;
                                            menuleft    - show popup menu from left side of button;

quit - quit the Talisman;
about  - show about window;
minimize    - hide Talisman window;
shutdown  - show Restart/Shutdown dialogue;
logoff    - log off current user;
moved  -    move the child form;
closeform  - close the child form and show the previous form;
showdesktop    - minimize all applications and show the Talisman desktop;
open    - open    theme;
home  - return to default theme;
refresh    - refresh active form;
connect <Connection Name>    - Dialup connectiont;

wavplay <filename>  - play a wav file;
pause <N>  - N is a delay in    seconds/10:
write <form number> <object name> <field number> <value>    - change any property of an object from the
command string. Caution! This is a very dangerous command, therefore it can change any value in Talisman's 
database component without any limitations and protections. You must know the organization of database 
component, runic.db, to use this command.

Field and Value descriptions: 

Field Description Type of Value 



1 Form Number of the Form Integer 
2 Number Number of object in current Form Integer 
3 Top Y-Coordinate of object in pixels Integer 
4 Left X-Coordinate of object in pixels Integer 
5 Width Width of object in pixels Integer 
6 Height Height of object in pixels Integer 
7 Path Path or command String 
8 Hint Caption or hint for buttons String 
9 Type Cannot be changed from the command string. NA 
10 Color Color of object Decimal value of RGB color 
11-14 Pictures Cannot be changed from the command string. NA 
15 Font Font Name String 
16 Size Font Size Integer 
17 FontType Font style: normal, bold, italic or bold italic 

n = normal
b = bold
i = italic
z = bold italic 

18 FontColor Font Color Decimal value of RGB color 
19 X X displacement of text field in pixels Integer 
20 Y Y displacement of text field in pixels Integer 
21 W Not used NA 
22 H Not used NA 
23 Dir Current word directory String 
24 Name Name of object String 
25 Memo Field for any text data <64kb String 

draw <x> <y> <filename>    - draw a picture (filename) on the form with the left corner of picture in x,y.
drawframes <x> <y> <frames> <delay> <filename.bmp>    - draw an animation from BMP picture (filename)
on the form with the left corner of picture in x,y. Delay - delay in milliseconds between frames. Frames - number of 
frames in *.bmp file.
enter <object name>    - run the command string of any other object .
changewallpaper <N form> - open "Open picture" dialog and change wallpaper of form;
changeformcolor <N form> - open "Select color" dialog and change color    of form.

mycomputer    - show MyComputer window;
mydoc    - show My Documents window;
network - show NetworkNeighborhood window;
dialup - show DialupNetwork window;
recycle - show RecycleBin window;
controlpanel - show Control Panel window;
desktop - show Desktop folder;
programs - show Programs folder;
documents - show Recent folder;
printers - show Printers folder;
fonts - show Fonts folder;

run    - show Run dialogue;
findfile    - show FindFile dialogue (not works in shell mode);
Go to form XXX    - show the form number XXX;
Popup form XXX  - popup the form number XXX;

htmlback object_name      - 
htmlforward object_name
htmlhome object_name
htmlrefresh object_name
htmlstop object_name
htmlurl object_name <URL>

*.tscr file    - a text file with one Talisman's command on each line. 
*.mnu file    - a custom menu file. For example menu from 3 lines:

      [menu]
      first=calc.exe;pause 10;wavplay start.wav
      second=charmap.exe
      third=script.tscr



Control Panel commands:
Accessibility Options: control access.cpl
Add New Hardware: control sysdm.cpl add new hardware
Add/Remove Programs: control appwiz.cpl
Date/Time Properties: control timedate.cpl
Display Properties: control desk.cpl
FindFast: control findfast.cpl
Internet Properties: control inetcpl.cpl
Joystick Properties: control joy.cpl
Keyboard Properties: control main.cpl keyboard
Microsoft Exchange (or Windows Messaging): control mlcfg32.cpl
Microsoft Mail Post Office: control wgpocpl.cpl
Modem Properties: control modem.cpl
Mouse Properties: control main.cpl
Multimedia Properties: control mmsys.cpl
Network Properties: control netcpl.cpl
Password Properties: control password.cpl
Power Management (Windows 95): control main.cpl power
Power Management (Windows 98): control powercfg.cpl
Printers Properties: control main.cpl printers
Regional Settings: control intl.cpl
Sound Properties: control mmsys.cpl sounds
System Properties: control sysdm.cpl



Locations and Moving Buttons.
Buttons are initially placed on the screen at the location where you right clicked to start the Button Wizard. Buttons 
can be moved once they have been finished. Here's how. In the Edit Mode, left click on the button, but keep your 
right mouse button pressed. This will bring up a dashed line around the button and the cursor will change. Hold the 
left mouse button down for about one second, then while still holding it down, drag the bounding box (the button 
stays in place, but the dashed box moves) to the location where you want it. Release the left mouse button. The 
button should appear in the new location. More precise positioning can be accomplished in the Talisman Editor.
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Making Changes
As in creating buttons and adding pictures and text blocks, almost all of the editing of those objects can be 
performed using the right mouse click pop-up menu in the Edit Mode. The menu selection "Properties..." can be 
ignored. When the cursor is placed over an object to be edited, the pop-up menu becomes context sensitive; that is,
it displays those items that can be changed for that particular object 

Buttons.
Picture Buttons.

Transparent Color: See Color and Transparency.
Font: Used to change font used for the text string; opens the standard Windows font dialog box. Font size and color
are also changed here. If the color is changed, it only affects the UP color. Changes to the HIGHLIGHT color must be 
made in the Object Editor.
Command: Used to change the application to start or command;
Text:    Used to change the label/hint text. Symbol "*" in the begining    is a command to use the text as label.

Text String Buttons.

Font: Used to change font used for the text string; opens the standard Windows font dialog box. Font size and color
are also changed here. If the color is changed, it only affects the UP color. Changes to the HIGHLIGHT color must be 
made in the Object Editor.
Command: Used to change the application to start or command;
Text:  Used to change the text.
Hot Zone Buttons.

It is a Picture Button without pictures.

Pictures.
Transparent Color: See Color and Transparency.
Filename: Used to change the picture; opens the standard Windows Open dialog box.

Text Blocks.
Font: Changes the font used in the text block; opens the standard Windows font dialog box. Font size and color are 
also changed here.

Forms.
The Talisman Main Picture or form is basically the background that all the objects sit on. You can change this 
background in two ways: assigning a picture or changing its color.
Changing the color: If you do not want to use a tiled picture background, you can change the color from black. 
Selecting "Color" opens the standard Windows color picker. Choose a color, click "OK" and the background changes.
Autohiding the form: If you do not want the form to autohide (that is, disappear when you move the cursor off 
the form), deselect "Autohide."
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Moving the Form
Once you have changed the form's size to something smaller than "full size," you can move it to where you want it. 
In the Edit Mode, select New>Button. In the command page of the Button Wizard, select "Moved" from the drop 
down menu and select textstring as the button type (you can select any of the three button types, but this button is
temporary, so why put a lot of effort into it). On the text page, key in some letters and click finish. Once out of the 
Editor, click and hold on the Move Button you just created. When the dotted line bounding box appears, you can 
reposition the form where you want it. After you finish moving the form, delete the Move Button (Object>Delete).

Moving a "Full Size" Form

A "full size" form can be moved just like a smaller form. Talisman will only display that part of the form still 
remaining within the boundary of the Base Form’s defined size. This means that at least two edges of the "full size" 
form will be the same as the Theme's edges.

Placement of a Child Form

Moving the form establishes its position relative to the top left corner of the Theme. Placement of the form, on the 
other hand, deals with its location relative to its invoking button. The invoking button can either be visible along 
with the form or hidden by the form. It’s your choice, but remember that if you want to the form to autohide, the 
form must cover the invoking button.

Autohiding a Child Form

A Child Form may be autohidden or not. Use Object>Autohide to control this attribute. Autohide only works when 
the form hides the invoking button.
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New Command.
Contains sub-commands: 

Button: Creates a new interactive object using a Button Wizard.
Picture: Creates a new decorative object using the Windows Open dialog box. This object is just a pointer to the 
disk location of the picture.
Shape: Creates a rectangle with any solid color without any command (like a picture button). It eliminates the need
to create rectangular color blocks in an outside graphics editor and add them as pictures.
Text block: Creates a new object for a block of text.
Form: Creates a new form with one "back button."
Theme: This command is used to start a new Theme. When selected, a popup dialog asks for the name of the new 
theme, creates a folder for it in the Themes subdirectory, and creates a new Runic.db and related files in the folder. 
The Theme created consists of one screen size form.



Talisman Object Editor (TOE)

Using The Talisman Object    Editor (TOE).

This part of the guide provides additional information for the advanced user. Its focus is on the Object Editor and 
how it can be used to refine a Theme. The Editor cannot be used to add objects to a Theme. Objects can only be 
added using the Edit Mode right click popup menu “New.”
The Editor is the heart and soul of getting Talisman to "do its thing." The Editor is the GUI to the database records 
and fields. The following is a description of the Editor's elements of the Editor. The Editor window consists of three 
parts: on the left, a tree diagram showing the structure of the Theme; in the center, all the information about the 
currently selected object and editing controls; and on the right, Editor Control Buttons.

Tree Diagram
Editor Control Buttons
Object Information Window
Internal Commands
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Organization of Talisman
Talisman's Basic Parts

The program consists of 3 parts:
The file talisman.exe (and also the library syspad.dll) is the main component.
The main database component is runic.db (and the files runic.mb, runic.px). These were created using Borland's 
Paradox. All objects and their properties are stored in it. The starting base should be placed in the working 
catalogue of the program. All additional bases can be placed anywhere. They and their related files must, however, 
be named "runic."
The Borland Database Engine, BDE 4.0, is the binding element between the database and the program. While 
BDE 4.0, in its runtime form, contains many functions that are not needed for Talisman the program cannot work 
without it.

Visible Interface of the Program: Forms and Objects.

Forms are the foundations on which objects reside. A Theme may consist of one form with many objects or several 
forms each with its own collection of objects. Each form has its own number. The main form is numbered 0 (zero) 
and is the main window of the program. It is the form seen when the program starts. Each subsequent form will be 
numbered consecutively after that starting with 2, then 3, then 4, and so on. All subsequent forms are child 
windows of the main form. 
An object can be a button, a picture or a text block. Objects can be either interactive or decorative. An interactive 
object is one that ultimately results in the starting of an application. A decorative object does not start any action. 
Notwithstanding its usefulness to the user, a text block is decorative. The objects inside each form, like the forms 
themselves, are by default numbered. For example, the main form, Form 0, may have 10 objects inside it. Each of 
the 10 objects will have a number, beginning with 2 (the form itself is object 1) and ending with 11. Objects can be 
added to or subtracted from a form.

Organization Of Database Component, runic.db

The database Runic.db contains 25 records.

1. Form - number of form
2. Number - number of object in current form
3. Top - y-coordinate of object in pixels from top of current form, except for form 0 (zero), then it is the coordinate 
from the top edge of the screen.
4. Left - x-coordinate of object in pixels from left of current form, except for form 0 (zero), then it is the coordinate 
from the left edge of the screen.
5. Width - width of object in pixels
6. Height - height of object in pixels
7. Path - full path of associated file or name of internal shell's command
8. Hint - caption or hint or textstring for text buttons
9. Priznak - type of object (button, picture etc)
10. Color - color of object
11. Pic1 - Image 1
12. Pic2 - Image 2
13. Pic3 - Image 3
14. Pic4 - Image 4
15. Font - fontname
16. Size - font size
17. FontType - font style (normal , bold, italic)
18. FontColor - font color
19. X - X displacement of text field in pixels
20. Y - Y displacement of text field in pixels
21. W - not used
22. H - not used
23. Dir - current work directory



24. Name - name of object
25. Memo - field for any text data <64kb
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Pixel Measurements
Question: Sometimes it would be useful to know about where on the screen an object should go or is. Is there 
an easy way to do that?

Answer: MicroFox Software has created a virtual ruler app called Screen Ruler. It comes in two versions: the 
freeware version only measures pixels; the shareware version has other units of measurement. The text file 
accompanying the app says:
Screen Ruler is a great virtual ruler ready to be dragged around on your computer screen. This Windows 95/NT 32bit
application is very useful to measure objects in Pixels. It features a vertical or horizontal orientation, a dynamic 
mouse measurement tracking, custom length, plus it can also remain on top, above all windows. Try it! Named 
"Cool Tool" by Internet World magazine. Very handy when designing Web Pages and other screen layouts. The 
registered version is even better.

http://www.kagi.com/microfox/



Registration
See also: Registration in    Europe 
                                Registration in Russia

Talisman is distributed as Shareware. You may use the shareware version for 30 days. If after 30 days you would like
to continue using it, then You should purchase a license. After you pay, you receive Registration Name and 
Registration key to tell Talisman that you have paid the shareware fee.

The fee for registered version of Talisman is: 

Single user license      $25.00.

Talisman CDROM*....$45.00

Site license**.............$500.00 

*CDROM: Talisman (one user license) and more 100 themes. Abracadabra    (unregistered shareware-version), 
Melody (unregistered shareware-version), IconTOY (unregistered shareware-version), CD-version of Lighttek's 
website. This is not boxed, CD-R disk writed individually for each order!
**Site licenses cover a single organization for an area of up to one hundred miles (160 km) in radius.

We accept the following types of payment: Credit card, Fax, Phone, Mail, Cash. All payment must be in US currency. 
On payment approval we'll send you the registration key which will remove all limitations of unregistered version. 
Your registration will be valid for all future versions 1.x.
If you do not get your registration key within a reasonable amount of time (two business days for credit card 
payments or two weeks for other payments), please notify us about that! We're very sorry for any inconvenience 
caused by those delays.

1. Through the World Wide Web. 

This is the fastest and easiest way. Your credit card information is sent directly to the credit card processor in a very 
secure manner, so that nobody else can see it. That protects you by ensuring that nobody but you and the credit 
card processor will see your card.
You can go directly to the order page: 

https://www.regnow.com/softsell/nph-softsell.cgi?item=1333-4      ( Payments in US$)

https://secure.element5.com/register.html?productid=104136    ( Payments in Euro, DM and US$)

Talisman CDROM: https://secure.element5.com/register.html?productid=133413    



2. Telephone and Fax Orders 

These types of orders should include ALL information contained on the Order Form. 
Telephone 
Toll Free: 877-353-7297
Regular: 425-392-2294 
Fax 
Toll Free: 888-353-7276
Regular: 425-392-0223 

You should include an additional $2.50 per order for Fax Orders or $3 for Telephone orders. 

3. Paying by Check via Postal Mail 

You should make checks payable to Universal Commerce, Inc., including the product's ID (for Talisman 1333-4) on 
the "memo" of the check. All order information except credit card information should be included in the Order Form 
mail to: 

Universal Commerce, Inc.
ATTN Orders
PO Box 1816 Issaquah, WA 98027
USA

You should include an additional $2.50 per order for Mail orders. 

Registration Benenefits
Object Editor is available after registration.
No nags.
Lifetime technical support including support via e-mail.
FREE upgrade to new versions during the life of version 1.x. 
Product notification by e-mail. 
Beta testing for newest version.

 



Registration in Europe

One user- license price: 25Euro (45DM for Germany)

Online Registration:

https://secure.element5.com/register.html?productid=104136

Paying by Check: 

All order information except credit card information should be included in the Order Form mail to: 
Andreas Brueckmann, 
Perleberger Weg 33,
40593 Duesseldorf, Germany

Information:
e-mail: proauto@gmx.de
+49-179-2040181
+49-179-2040182
+49-2204-916686, fax

Wiretransfer:

For: Andreas Brueckmann
Bank: Deutsche Bank 24 
Bank Code (BLZ): 37070024
Account: 2706661

Information:
e-mail: proauto@gmx.de
+49-179-2040181
+49-179-2040182
+49-2204-916686, fax



Ðåãèñòðàöèÿ â Ðîññèè è ñòðàíàõ ÑÍÃ

Âàðèàíò ðåãèñòðàöèè, äåéñòâóþùèé òîëüêî äëÿ æèòåëåé Ðîññèè, ñòðàí    ÑÍÃ è Ïðèáàëòèêè. Ñòîèìîñòü ðåãèñòðàöèè
ñòî ïÿòüäåñÿò ðóáëåé.

Ñòîèìîñòü CD-âåðñèè 350 ðóáëåé.. Äëÿ ðåãèñòðàöèè è ïîêóïêè ïðîãðàììû, çàïîëíèòå ôîðìó ïî àäðåñó:    
http://www.shareg.com/req.php3?prodid=24&referer=476



Sample scripts

Button Scripts 

Typical: opens one application; for example, Windows Calculator: c:\windows\calc.exe 

Scripted: 

opens two applicaitons; for example, Windows Calculator and Windows Notepad: 

c:\windows\calc.exe;c:\windows\notepad.exe

Note the semicolon separating the two applications. In scripting a button command, *.lnk shortcuts may also be 
used. 

opens a file and an application; for example, a picture and Windows Notepad: 

c:\images\pic1.jpg;c:\windows\notepad.exe 

Menu Scripts 

Scripts used in *.mnu files take the same form as button scripts. 

Autostart Scripts 

Scripts used in the autostart command on the Theme Window of the Editor take the same form as button scripts. 
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Scripting

Talisman, like many other programs, uses scripting to extend its functionality. In brief, scripting is a series of 
commands that are executed in series. Since it is similar to scripting and can actually include scripts, we have 
included a discussion of the menu function in this section. Since scripts can be used in an almost unlimited number 
of ways, we will limit this presentation to enough to demonstrate their power and flexibility.

Scripts can be used as:
- a button command to initiate a series of actions; 
- a menu item to initiate a series of actions; 
- in the autostart command to initiate a series of actions when Talisman startsup. 

Scripts can use any Talisman command, execute any program installed on the computer, or open any file for which 
there is a Registry file associaton. It is important to remember that with scripting, buttons are not limited to a single
command. 

Separator in one string scripts is ";". Limitation of one string is 255 symbols. Scripts with more than 255 symbols 
must be saved as *.tscr file (text file with one command in string).

Sample Scripts
Storing Scripts
Special Commands



Sounds in Talisman
There are six events for which a sound can be played. Any wav file can be used, but for a specific event the wav 
must have a specific name. Also, to play, the wav files must be in the Theme directory for the particular theme for 
which you want sound. The sound possibilities are: 
· sound when a new Theme is loaded: use a wav named "start.wav" 
· sound when mouse moves over button: use a wav named "over.wav" 
· sound when a button is clicked: us a wav named "click.wav" 
· sound when showing a new form (Command: Go to form xxx): use a wav named "form.wav" 
· sound for a popup form (Command: Popup form xxx): use a wav named "popup.wav" and 
sound for a popup menu: use a wav named "menu.wav"

Also you can add the wavplay <filename.wav> command to any command string to play your sound. 
For example:

Command string:    explorer;wavplay start.wav will start exporer.exe and play sound.wav file.
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Special Commands
There are three special commands that may be used by themselves, but more effectively as part of a script or 
menu file; and a two commands that make sense only within a script or a menu file containing a script.

Draw: draws a *.bmp or *.jpg on the screen at a specific location. 

Syntax: draw 50 50 [path], where "50 50" indicates the top left corner position of the graphic. 
Usage: may be used by itself or as part of a script or menu file. 
Examples: 

By itself: draw 50 50 c:\images\pic10.jpg 
In a script file: draw 50 50 c:\images\pic10.jpg;c:\windows\calc.exe 
In a menu file: Picture 1=draw 50 50 c:\images\pic10.jpg 

Drawframes: draws an animation from *.bmp or *.jpg files on the screen at a specific location. 

Syntax: drawframes <x> <y> <frames> <delay> <filename> , where X,Y .indicates the top left corner 
position of the graphic. Delay - delay in milliseconds between frames. Frames - number of frames in *.bmp file.

Example: 

By itself: drawframes 250 250 10 8 c:\images\pic10.jpg 
In a script file: drawframes 250 250 10 8 c:\images\pic10.jpg;pause 10;drawframes 250 250 10 8 c:\
images\pic11.jpg 
In a menu file: Show 1=drawframes 250 250 10 8 c:\images\pic10.jpg 

Wavplay: plays a specified wav file. 

Syntax: wavplay [path] 
Usage: may be used by itself or as part of a script or menu file. 
Examples: 

By itself: wavplay c:\sounds\iamready.wav 
In a script file: wavplay c:\sounds\iamready.wav;c:\windows\calc.exe 
In a menu file: Sound 1=wavplay c:\sounds\iamready.wav 

Pause: creates a pause of a specified length in tenths of a second increments. 

Syntax: pause 10, where "10" indicates that the duration of the pause is 10 10ths of a second or one second. 
Usage:as part of a script or menu file. 
Examples: 

In a script file: draw 50 50 c:\images\pic10.jpg;pause 10; draw 50 50 c:\images\pic11.jpg       Note: this 
leaves the last picture on the screen. 
In a menu file: Picture Series 1=draw 50 50 c:\images\pic10.jpg;pause 10;draw 50 50 c:\images\pic11.jpg
Note: this leaves the last picture on the screen. 

Refresh: refreshes the form on which the command resides. 



Syntax: refresh 
Usage: as part of a script or menu file. 
Examples: 

In a script file: draw 50 50 c:\images\pic10.jpg;pause 10; draw 50 50 c:\images\pic11.jpg;refresh Note: 
this returns the screen to its state before the first picture was drawn. 
In a menu file: Picture Series 1=draw 50 50 c:\images\pic10.jpg;pause 10;draw 50 50 c:\images\
pic11.jpg;refresh Note: this returns the screen to its state before the first picture was drawn. 
Note: combinations of "pause" and "refresh" can be used to create an interval of no picture; for example, draw 50 
50 c:\images\pic10.jpg;pause 10;refresh;pause 10;draw 50 50 c:\images\pic11.jpg, where pict10 is held 
on screen for 1 second, the screen is returned to its pre-pict10 state for 1 second, then pic11 is drawn. 

Write: changes a specific field in the database. This command is both very powerful and very dangerous. It 
should be used with great caution and only after a theme has been backed up. 

Syntax: write <N form> <objectname> <N field> <value>, where "N form" is the form number, "objectname" 
is the name of the object shown in the Editor, "N field" is the number of the field to be changed and "value" is the 
new value for the field. Generally, this command would be used to toggle a particular obect among several different
values. 
Usage: by itself or as part of a script or menu file. 
Examples These examples are based on changing the path of a picture, objectname: face, on form0, where its initial
value is the string "c:\images\pic01.bmp". 

By itself: write 0 face 7 c:\images\pic02.bmp;refresh       Note: to return the picture to the original, there would 
be another button with the command write 0 face 7 c:\images\pic01.bmp;refresh 
In a script file: write 0 face 7 c:\images\pic02.bmp;refreshIn a menu file: Picture 2=write 0 face 7 c:\
images\pic02.bmp;refresh          Note: to return the picture to the original, there would be another menu item with
the command    Picture 1=write 0 face 7 c:\images\pic01.bmp;refresh 
Note: the "refresh" command at the end causes the picture to actually change; without it, the change would be 
written to the database, but the picture would not have changed. 
    
Field and Value descriptions: 

Field Description Type of Value 

1 Form Number of the Form Integer 
2 Number Number of object in current Form Integer 
3 Top Y-Coordinate of object in pixels Integer 
4 Left X-Coordinate of object in pixels Integer 
5 Width Width of object in pixels Integer 
6 Height Height of object in pixels Integer 
7 Path Path or command String 
8 Hint Caption or hint for buttons String 
9 Type Cannot be changed from the command string. NA 
10 Color Color of object Decimal value of RGB color 
11-14 Pictures Cannot be changed from the command string. NA 
15 Font Font Name String 
16 Size Font Size Integer 
17 FontType Font style: normal, bold, italic or bold italic 

n = normal
b = bold
i = italic
z = bold italic 

18 FontColor Font Color Decimal value of RGB color 
19 X X displacement of text field in pixels Integer 
20 Y Y displacement of text field in pixels Integer 
21 W Not used NA 
22 H Not used NA 
23 Dir Current word directory String 
24 Name Name of object String 
25 Memo Field for any text data <64kb String 
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Storing Scripts
Scripts can be stored as a button command, in a Talisman script, *.tscr, file or a Talisman menu, *.mnu, file.

Button Command 
Scripts stored as a button command are shown in the command line of the button with ";" as separator..For a big 
scripts recomended to use a *.tscr files.

*.tscr files are text files with the extension tscr with each command on a separate line. The *.tscr then becomes a 
button's command. 
Example: a button, named "Expenses" opens Windows Calculator and Windows Notepad through a script file. The 
script file might be named "expenses.tscr" and stored in same directory as the theme, although it could be stored 
anywhere on the system. Shortcuts, *.lnk, may be used in *.tscr files. 

c:\windows\calc.exe
c:\windows\notepad.exe 

*.mnu Files 
*.mnu files are actually used to create popup menus. This eliminates the need to populate a form with many 
buttons. Just as Talisman itself uses a right click popup to access its commands, a user can create a button and 
assign to its command a *.mnu file to create a popup of available commands. Like a *.tscr file, a *.mnu file is a text 
file with the extension mnu with each command on a separate line. It may be stored in the same directory as the 
theme or anywhere else on the system. Menu files may be specified in the Button Wizard command line through the
popup button at its right in the item Menu>local menu from file. Semicolons at the beginning of a line may be used 
to hide a menu item. 
Example: a button, named "Graphics" opens a menu containing two graphics applications. The menu file might be 
named "graphics.mnu." Note that the file begins with the word menu in brackets as the first line. 

[menu]
Photoshop=c:\program files\photoshop\photoshp.exe
Paint Shop Pro=c:\program files\paint shop pro 6\psp.exe 
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TOE: The Button Window
For buttons, the graphics window shows a preview of the assigned graphic and three tabs below it: Normal, 
Highlight and Click. Clicking on one of those tabs shows the graphic assigned to the corresponding button state. The
graphics window editing buttons at the right side work for the specific button state selected.

The graphics window below the title bar has five to seven editing buttons along the right side. The graphics editing 
buttons are:

Open: Opens the standard Windows “Open” dialog; 
Copy: Copies the graphic in the window to the Windows clipboard; 
Paste: Pastes the contents of the clipboard into the object’s window; 
Delete: Deletes the graphic in the window; 
Undo: Undoes the last change to the graphic in the window; 
Color Picker (Eye Dropper): Used to select a color as the transparent color (See Color and Transparency); and 
Select Color (a Down Arrow): Used to select a color from the standard Windows color picker. 
Save button Save    button in BTN3 or BMP file.

Top: The measurement in pixels from the top of the parent form. A top coordinate of 0 (zero) would place the child 
form at the top edge of the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of
the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside 
the visible desktop or Talisman window.

Left: The measurement in pixels from the left edge of the parent form. A left coordinate of 0 (zero) would place the 
child form at the left edge of the parent form, while a coordinate of 15 would place it 15 pixels in from the left edge 
of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is 
outside the visible desktop or Talisman window.

Height: The height of the object in pixels.

Width: The width of the object in pixels.

Use text as hint or label: When a button is created, the third dialog window assigns a name for the button. By 
default, Talisman uses the textstring as a label for the button and displays that label below the button. This option 
permits the use of the textstring as a hint, rather than a label, that appears when the cursor moves over the button.

Text: The textstring used for the hint or label.

Font: The font to to be used for the text label/hint. The font, size and color may be changed by using the buttons at
the right.

Command: The Talisman built in command or path statement for the executable. See Command menu for a 
description of the menu commands. See Internal Commands for a description of all available commands. See 
Scripting for a a description of the Talisman's script system.

Path: The working directory for the application. By default, this path is unassigned.Font: The font, size, style and 
color used in displaying the hint or label. When the button is a textstring, two colors appear. Color 1 is the UP color 
and Color 2 is the HIGHLIGHT color.
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TOE: The Form Window
For Form0
Graphics Window: A graphics window below the title bar with four editing buttons along the right side. The 
graphics editing buttons are:
One Small Star: centers the background image on the screen. 
Four Stars: tiles the background image on the screen. 
One Large Star: stretches the background image on the screen. 
Select Color (a Down Arrow): Used to select a background color from the standard Windows color picker. 
Wallpaper: specifies the path to the image to be used for the background. The button at the right opens the 
standard Windows Open Dialog. 
Left: The measurement in pixels from the left edge of the screen. A left coordinate of 0 (zero) would place the form 
at the left edge of the screen, while a coordinate of 15 would place it 15 pixels in from the left. Negative coordinates
(e.g., -3) are also possible, but they indicate that a portion of the object is outside the visible desktop. 
Top: The measurement in pixels from the top edge of the screen.
Height: The height of the object in pixels. 
Width: The width of the object in pixels. 
Fullscreen Form: Used to set the form to the full screen size. Useful when designing a theme that might be 
displayed on either different size monitors or monitors set at different resolutions. 
Autohide form: Form0 cannot be autohidden. 
Semitransparent form: Form0 cannot be semitransparent. 

For All Other Forms 
Graphics Window: For buttons and pictures there is a graphics window below the title bar with four editing 
buttons along the right side. The graphics editing buttons are:

One Small Star: centers the background image on the screen. 
Four Stars: tiles the background image on the screen. 
One Large Star: stretches the background image on the screen. 
Select Color (a Down Arrow): Used to select a background color from the standard Windows color picker. 
Wallpaper: specifies the path to the image to be used for the background. The button at the right opens the 

standard Windows Open Dialog. 

Top:
Parent Forms: For a parent form (either primary or secondary; See Forms for an explanation of parent forms), top is 
measured from the top edge of the screen. A top coordinate of 0 (zero) would place the form at the top edge of the 
screen, while a coordinate of 15 would place it 15 pixels down from the top. Negative coordinates (e.g., -3) are also 
possible, but they indicate that a portion of the object is outside the visible desktop or Talisman window. 
Child Forms and Objects: For a child form (See Forms for an explanation of child forms) and all objects, top is 
measured from the top of the parent form. A top coordinate of 0 (zero) would place the child form at the top edge of
the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of the parent. Negative 
coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside the visible desktop or
Talisman window. 

Left:
Parent Forms: For a parent form (either primary or secondary), left is measured from the left edge of the screen. A 
left coordinate of 0 (zero) would place the form at the left edge of the screen, while a coordinate of 15 would place 
it 15 pixels in from the left. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the 
object is outside the visible desktop or Talisman window. 
Child Forms and Objects: For a child form and all objects, left is measured from the left edge of the parent form. A 
left coordinate of 0 (zero) would place the child form at the left edge of the parent form, while a coordinate of 15 
would place it 15 pixels in from the left edge of the parent. Negative coordinates (e.g., -3) are also possible, but 
they indicate that a portion of the object is outside the visible desktop or Talisman window. 
Height: The height of the object in pixels. 
Width: The width of the object in pixels. 
Background color: Used to set the color of the form. This is overridden when a background image has been 



selected for the form. 
Autohide form: Causes the form to disappear automatically when the cursor moves off the form. 
Semitransparent form: Normally a form is opaque. If semitransparent is selected, what is behind the form will 
partially show through. If, however, the form’s background color is black (RGB = 0,0,0) and semitransparent is 
selected, the form becomes transparent. This does not work with the Base Form. 
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TOE: The HTML Object Window
Filename: The address for the web page, local file or local directory you want to open automatically in the in the 
HTML Page object:

A web page: use the URL; for example, http://www.lightek.com 
A local file: use the path (clicking on the button to the right will open the standard Windows Open dialog box, the 
browse to the file); for example, c:\talisman\readme.txt 
A local directory: use the path (the browse button to the right cannot be used); for example, c:\talisman 
Top: The measurement in pixels from the top of the parent form. A top coordinate of 0 (zero) would place the HTML 
Page object at the top edge of the parent form, while a coordinate of 15 would place it 15 pixels down from the top 
edge of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is 
outside the visible desktop or Talisman window.

Left: The measurement in pixels from the left edge of the parent form. A left coordinate of 0 (zero) would place the 
HTML Page object at the left edge of the parent form, while a coordinate of 15 would place it 15 pixels in from the 
left edge of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the 
object is outside the visible desktop or Talisman window.

Height: The height of the object in pixels. 

Width: The width of the object in pixels.
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TOE: Contents of the Main Menu Window
The Main Menu Window contains checkboxes for all the right click popup items that can be enabled or disabled. A 
check in the box means the item will appear in the right click popup menu. 
All items in this window are also editable in the theme.ini file in the theme's directory.
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TOE: The Picture Window
For pictures there is a graphics window below the title bar with one button along the right side. The button is the 
Color Picker (Eye Dropper) to select a color as the transparent color (See Color and Transparency). 

There are three additional items in this window: 

Top: The measurement in pixels from the top of the parent form. A top coordinate of 0 (zero) would place the child 
form at the top edge of the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of
the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside 
the visible desktop or Talisman window. 
Left: The measurement in pixels from the left edge of the parent form. A left coordinate of 0 (zero) would place the 
child form at the left edge of the parent form, while a coordinate of 15 would place it 15 pixels in from the left edge 
of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is 
outside the visible desktop or Talisman window. 
Filename: this shows the path to the picture. It can also be used to change the picture by changing its path by 
clicking on the button to the right. 
Align panel: specifies the align of object (to left, to right, to top, to bottom) and also height and width of object in 
relation to the form (allheight,allwidth).
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TOE: The Shape Window
Color: Shows the color of the shape object.

Top: The measurement in pixels from the top of the parent form. A top coordinate of 0 (zero) would place the child 
form at the top edge of the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of
the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside 
the visible desktop or Talisman window.

Left: The measurement in pixels from the left edge of the parent form. A left coordinate of 0 (zero) would place the 
child form at the left edge of the parent form, while a coordinate of 15 would place it 15 pixels in from the left edge 
of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is 
outside the visible desktop or Talisman window.

Height: The height of the object in pixels.

Width: The width of the object in pixels.

Wallpaper: specifies the path to the image to be used for the background. The button at the right opens the 
standard Windows Open Dialog. 

Align panel: specifies the align of object (to left, to right, to top, to bottom) and also height and width of object in 
relation to the form (allheight,allwidth).

Transparency - enable/disable transparency for shape.

Border color: Shows the color of the border.

Border width: The width of the border in pixels.
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TOE: The Text Block Window
Top: The measurement in pixels from the top of the parent form. A top coordinate of 0 (zero) would place the child 
form at the top edge of the parent form, while a coordinate of 15 would place it 15 pixels down from the top edge of
the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is outside 
the visible desktop or Talisman window.

Left: The measurement in pixels from the left edge of the parent form. A left coordinate of 0 (zero) would place the 
child form at the left edge of the parent form, while a coordinate of 15 would place it 15 pixels in from the left edge 
of the parent. Negative coordinates (e.g., -3) are also possible, but they indicate that a portion of the object is 
outside the visible desktop or Talisman window.

Height: The height of the object in pixels. 

Width: The width of the object in pixels.

Background color: Shows the color of the background for the textblock. This background is used only when the 
textblock is edited. It has no effect when in Work Mode.

Font: The font, size, style and color used in displaying the textblock.
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TOE: Contents of the Theme Window
The Theme window contains eight sets of items that can be changed.

Screen Workarea: controls whether all or part of the screen will be used for the theme. 

Show system elements:    controls the following items appear : 
Talisman Taskbar: displays a Talisman Taskbar.
Talisman System tray (only for shell mode): displays a Talisman System Tray in shell mode of Talisman.
Windows taskbar    (only for application mode): displays a standard taskbar in apllication mode of 

Talisman 
Talisman Clock: displays a clock. 

Theme Always on Back: controls whether the Theme can be brought forward and above other open application 
windows by clicking on the Theme. 
Autostart: controls what happens when Talisman starts, just as the items in the Windows Startup Folder control 
what happens when Windows starts. This item is scriptable (See Adding Objects, Scripting for more information). 
The button to the right invokes a popup containing the following: Command menu 

All items in this window are also editable in the theme.ini file in the theme's directory.
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Talisman RT is a run-time version of Talisman without all functions of editing.
You can use Talisman RT (with themes created in Talisman) on PCs 
where you want to protect your interface from editing. 
Prices:

10 users                  $100.00
20 users                  $150.00
50 users                  $300.00
100 users              $500.00

Online registration Talisman RT:    http://www.regnow.com/softsell/nph-softsell.cgi?item=1333-5



Question: I installed Talisman on WinNT 4. There is an option where I can switch talisman to be the default shell 
instead
of Microsoft's when I log into Win NT. I logged into Talisman shell. Thereafter, I did an uninstall of Talisman while 
Talisman is the default desktop shell, and this time when I try to log into windows NT and I tried to access 
Microsoft's default desktop shell, NOTHING appears on the screen, the screen just drew a complete blank!!!

Answer: At first, plese read the documentation before shell switching! 

Step by step procedure to start Windows NT/2000 if you uninstall Talisman in shell mode of 
Talisman:

1) Start NT.
2) After logining press Ctrl-Alt-Del
3) Press "Task Manager".
4) Press "New Task".
5) Enter: "regedit.exe" and press "Ok".
6) Change the value of register key :
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows 
NT\CurrentVersion\WinLogon\Shell
from "../talisman/talisman.exe" in "explorer.exe"

Change the value of register key (if exist):
HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\Winlogon\Shell
from "../talisman/talisman.exe" in "explorer.exe"

7) Close regedit.exe.
8) Press Ctrl-Alt-Del
9) Logoff or Shutdown to restart Windows.

For Windows 95/98:

1) Restart your computer - either turn it off, then back on or hit the reset button.

With this step timing is critical. As your computer reboots, it will run through a series of checks (memory, hard 
drives, etc.). After the checks, it will normally display a screen showing your basic hardware configuration. When it 
does that, push the F8 key (Windows95 and Windows98 do things a little differently here: Win95 shows a statement 
Starting Windows95, but Win98 does not). Shortly after pushing the F8 key, you will be presented with a menu of 
startup options.

2) Select "Start at command prompt"

3) When you get a c:> prompt, key in 
edit c:\windows\system.ini 
(if your windows directory is named something else use that).

4) The screen will change and you will be presented with a basic text editor. Most likely, you won't be able to use 
your mouse, so you will have to navigate with the keyboard. Use the down arrow to get to the proper line (shell=), 
then change this string in
shell=explorer.exe



5) Exit the editor. The keystrokes are alt+f to open the File Menu; then x to exit; then y to save the changes.

6) Restart.

For Windows ME:

1) You need to have a bootable diskette and start computer from this diskette.

2)    When you get a c:> prompt, key in 
edit c:\windows\system.ini 
(if your windows directory is named something else use that).

3) The screen will change and you will be presented with a basic text editor. Most likely, you won't be able to use 
your mouse, so you will have to navigate with the keyboard. Use the down arrow to get to the proper line (shell=), 
then change this string in
shell=explorer.exe

4) Exit the editor. The keystrokes are alt+f to open the File Menu; then x to exit; then y to save the changes.

5) Restart.
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The Talisman window, menu commands
Popup Menu Work Mode

Once a Talisman Theme is open, right clicking with the mouse will pop-up a menu. The menu contains nine sets of 
commands. Eight correspond to the same ones as the right click menu in the Talisman Systray icon with the new 
one for switching to the Edit Mode. 

Switch to Edit Mode. Switches to the Talisman Edit Mode for adding or changing forms and objects. 
Task list. This displays a menu of all open applications. It performs the same function as Alt+tab. 
Applications. This provides a listing of the program groups and programs listed in the WindowsTaskbar’s 

Start>Programs. 
Theme. This has three options: 

Home returns to the Default Theme. 
Open Theme... is used to open another theme. 
Download Theme... connects to the ·Themes Section of the Talisman web site. 
Set as default sets the currently open theme as the Default Theme. This command tells Talisman 
to ignore the Theme in its directory and use the open Theme as the startup one.
This can be useful when the user has multiple Themes available and wants to alternate 
among them at the startup. Once a Theme has been defined as the default, 
selecting the Home command, when working on a non-default Theme, reinstates this Theme. 
Open Theme folder opens a Windows Explorer to the currently open theme's folder and displays its 

contents. 
The last option is a listing of all themes available as subfolders of the Talisman>Themes folder. 

Run and Find files. 
Run opens the Windows Run Dialog box. 
Find Files open the Find Files dialog. 

Show and Hide Desktop. 
Show maximizes the Talisman window and hides any application windows. 
Hide, available only in the application mode, minimizes the Talisman window. 

Help. This has four options. 
Contents opens the Talisman Help file. 
Talisman Homepage is a · link to the World Wide Web Home for Talisman. 
Online Users’ Forum is a · link to the World Wide Web Talisman Forum. 
Online Registration is a link to the World Wide Web page used to register Talisman. 

About/Registration gives information about the program and how to register to use it. 
Commands. This has seven options: Each opens the corresponding Explorer window: 

Desktop, 
Programs, 
Documents, 
Explorer, 
Control Panel, 
Recycle Bin, 
Shell Switcher, 
Display Properties. 

Shutdown and Quit. 
Shutdown opens the Windows Shutdown menu. 
Quit closes Talisman. Available only when Talisman is in Application Mode. 

Popup Menu Edit Mode

When the Edit Mode is selected, the right click pop-up menu displays the following commands. See the section 
Adding New Objects for more detailed information. 



Switch to Work Mode. Switches out of the Talisman Edit Mode and returns to the Work Mode. 
New. Contains seven sub-commands: 

Button: Creates a new interactive object using a Button Wizard. 
Picture: Creates a new decorative object using the Windows Open dialog box. 
This object is a pointer to the disk location of the picture. 
Shape: Creates a rectangle with any solid color without any command (like a picture button). 
It eliminates the need to create 
rectangular color blocks in an outside graphics editor and add them as pictures. 
Text block: Creates a new object for a block of text. 
HTML page: Creates an Internet Explorer Window as a part of the Theme. 
Form: Creates a new form with one "back button." 
Theme...: Creates a new theme. 

Copy, Paste and Delete. These become active once an object has been selected. 
Objects can be copied and pasted on the same form and from one form to another. 
When objects are copied and pasted, they retain the same characteristics as the original object. 
If the copied and pasted objects are interactive (a button, for example), 
the Filename it starts will need to be changed. Delete deletes the object clicked on. 
Context Sensitive Commands. This group of commands is object oriented and context sensitive; 
that is, depending on the object selected the available command will change. 
Possible commands are: 

Color: Brings up the standard Windows color picker for changing the background color of a form. 
Autohide: Causes a form to disappear when you move the cursor off the form. 
Transparent Color: Brings up the standard Windows color picker for defining the transparent color of an 

object. 
Font: Brings up the standard Windows Font dialog box for changing a font. 
Command: Brings up a Talisman dialog box for changing a button's command. 
Bring to Front and Send to Back. These two commands are used to reposition overlapping objects. 

Go to form Go to selected form. 
Hide Taskbar/Show Taskbar. Toggles the Windows Taskbar visible or invisible. 
Available only when Talisman is in Application Mode. 
Grid. Creates an invisible snap-to grid on a form that can be used in positioning objects. 
The scale is the distance between snap-to points on the grid. 
Settings Contains sub-commands: Program, Theme, Talisman Taskbar, Talisman Tray, Talisman Clock, Main 

Menu
Properties. This command displays the Talisman Editor for the selected object. 
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Theme Command.
Contains sub-commands: 

Set as default: This command tells Talisman to ignore the Theme in its directory and use the open Theme as the 
startup one. This can be useful when the user has multiple Themes available and wants to alternate among them as
the startup. Once a Theme has been defined as the default, selecting the Home command, when working on a non-
default Theme, reinstates this Theme



Tree Diagram
At the left side of the Object Editor window is a tree diagram showing the structure of the current Talisman Theme. 
Folder icons indicate forms. Below each folder, form, will be a listing of all the objects on the form. Each object has 
an icon and either a number or a name. The icon indicates the kind of object:
Theme icon: indicates a common theme's settings;
Button icon: indicates a button object;
Picture icon: indicates a picture object;
Text page icon: indicates a text block object;
Layer rectangle icon: indicates a shape object;
Red right arrow: indicates the object currently selected for editing.
HTML page icon: indicates a HTML object;
Inputbox icon: indicates a inputbox object;
By default, Talisman assigns a number to each form’s object. Unless the creator of the Theme has given the object a
name, the assigned number will appear in the tree diagram.
"Enter" and "Delete" keys are available in Object Editor's tree.
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Using Sound in a Theme
Question: Can I use sound in a Theme?

Answer: Yes, starting with Version 1.1. That version defined six events for which a sound can be played. Any wav
file can be used, but for a specific event the wav must have a specific name. Also, to play, the wav files must be in 
the Theme directory for the particular theme for which you want sound. The sound possibilities are: 
· sound when a new Theme is loaded: use a wav named "start.wav" 
· sound when mouse moves over button: use a wav named "over.wav" 
· sound when a button is clicked: us a wav named "click.wav" 
· sound when showing a new form (Command: Go to form xxx): use a wav named "form.wav" 
· sound for a popup form (Command: Popup form xxx): use a wav named "popup.wav" and 
sound for a popup menu: use a wav named "menu.wav"



Using Talisman as a Shell

1) Using the Talisman Shell Switcher

The simplest way to switch from the Windows Explorer shell — Windows95, Windows98, Windows ME, WindowsNT 
or Windows2000 — to Talisman as a shell is to use the application tss.exe included with the Talisman download. It is 
installed in the same directory as Talisman and must be used from that directory. You can also create your own 
button for it.
When tss.exe is executed, it displays a small dialog box with two choices: Talisman or Explorer. Click on the radio 
button for your choice, then "Ok". When "Ok" is clicked, the system.ini file is changed for users of Win95 and Win98,
or the registry is changed for users of WinNT Win2000. The next time you start Windows the shell of your choice will
be used.

Attention!    Do not uninstall Talisman in shell mode of Talisman. Return your shell in explorer.exe 
(useTalisman Shell Switcher tss.exe for it) and then uninstall Talisman from standard Windows shell.

Attention! Please read "What to do if the system will not startup with Talisman as the shell?" before 
shell switching! 

2) What to do if the system will not startup with Talisman as the shell?

Win 95/98:

If your system will not startup with Talisman as the shell, it is easy to go back to explorer.exe as the shell, but 
requires a step backward into the pre-Windows95 days of DOS. Here's what to do:

· Restart your computer - either turn it off, then back on or hit the reset button.
· With this step timing is critical. As your computer reboots, it will run through a series of checks (memory, hard 
drives, etc.). After the checks, it will normally display a screen showing your basic hardware configuration. When it 
does that, push the F8 key (Windows95 and Windows98 do things a little differently here: Win95 shows a statement 
Starting Windows95, but Win98 does not). Shortly after pushing the F8 key, you will be presented with a menu of 
startup options.
· Select Start at command prompt
· When you get a c:> prompt, key in edit c:\windows\system.ini (if your windows directory is named something 
else use that).
· The screen will change and you will be presented with a basic text editor. Most likely, you won't be able to use 
your mouse, so you will have to navigate with the keyboard. Use the down arrow to get to the proper line (shell=), 
then make the necessary changes.
· Exit the editor. The keystrokes are alt+f to open the File Menu; then x to exit; then y to save the changes.
· Restart.

Windows ME:

1) You need to have a bootable diskette and start computer from this diskette.
2)    When you get a c:> prompt, key in 
edit c:\windows\system.ini 
(if your windows directory is named something else use that).
3) The screen will change and you will be presented with a basic text editor. Most likely, you won't be able to use 
your mouse, so you will have to navigate with the keyboard. Use the down arrow to get to the proper line (shell=), 



then change this string in
shell=explorer.exe
4) Exit the editor. The keystrokes are alt+f to open the File Menu; then x to exit; then y to save the changes.
5) Restart.

Windows NT/2000:

1) Start NT.
2) After logining press Ctrl-Alt-Del
3) Press "Task Manager".
4) Press "New Task".
5) Enter: "regedit.exe" and press "Ok".
6) Change the value of register key :
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows 
NT\CurrentVersion\WinLogon\Shell
from "../talisman/talisman.exe" in "explorer.exe"

Change the value of register key (if exist):
HKEY_CURRENT_USER\Software\Microsoft\Windows
NT\CurrentVersion\Winlogon\Shell
from "../talisman/talisman.exe" in "explorer.exe"

7) Close regedit.exe.
8) Press Ctrl-Alt-Del
9) Logoff or Shutdown to restart Windows.

3) Manual settings

Windows 9x :

Changing System.ini in Windows95.
This procedure uses c:\talisman as the directory; if your directory is different, change it, but be sure to use the DOS 
8.3 names.

· Open a text editor such as Notepad
· Open c:\windows\system.ini (if your windows directory has a different name, substitute that name)
· Find the section that starts with [boot]
· Locate the line shell=explorer.exe
· Put a semicolon (;) in front of this line
· Move the cursor to the end of this line and hit the Enter key
· Key in the following new line: shell=c:\talisman\talisman.exe
· Save the changes and exit the text editor
· Restart Windows.
· To return to explorer.exe as your shell, follow steps 1 - 3, then remove the semicolon at the beginning of the 
line shell=explorer.exe and put a semicolon at the beginning the line shell=c:\talisman\talisman.exe. Then save the 
changes, exit the text editor, and restart Windows.
· You can create a Talisman button to automatically open system.ini in notepad. In the Edit Mode, select 
New>Button and in the command line, put notepad.exe c:\windows\system.ini, choose the button type and 
complete it as you normally would. 
Changing System.ini in Windows98.
This procedure uses c:\talisman as the directory; if your directory is different, change it, but be sure to use the DOS 
8.3 names. There are two ways to change shells: you can either use the Win95 steps above or use msconfig as follows:

· Choose Start>Run and key in msconfig
· Hit OK
· Click on the system.ini tab
· Click on the plus sign to the left of the [boot] folder to expand it
· Click new and in the textblock key in shell=c:\talisman\talisman.exe
· Hit enter
· Click the Move Down button to move it down so it is with the shell=explorer.exe line
· Uncheck the shell=explorer.exe



· Click OK and Yes when prompted to save the changes.
· Restart Windows.
· To return to explorer.exe as your shell, follow steps 1 - 3, check the line shell=explorer.exe and uncheck the line
shell=c:\talisman\talisman.exe, click OK and Yes when prompted to save the changes, then restart Windows.

Windows NT4/2000:
1) To make Talisman the system wide shell:
· Open up regedit and goto:
                                HKLM\Software\Microsoft\Windows NT\CurrentVersion\WinLogon\Shell
· Change the value from Explorer to Talisman
2) To make Talisman the shell for the current user:
· Open up regedit and create the key:
                                HKCU\Software\Microsoft\Windows NT\CurrentVersion\Winlogon\Shell
· Give this new key the value Talisman.
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Using a Theme Developed at One Resolution at Higher 
Resolutions

Question: I have a 1024x768 screen or 1200x... How I can use an 800x600 theme in fullscreen mode?

Answer: The answer depends how the background is constructed. If it is like the Boldovsky Theme 1, there 
isn't really anything you can do except center the theme and use a Windows wallpaper to complement it. If it is 
composed of interlocking pieces (like javascript buttons on web pages) that together make up a picture, you might 
to be able to use it by adapting #3, below. 
If it uses a solid color background or a picture, single or tiled: 

1. 800x600 partial screen with solid color background: you should be able to use it at a higher resolution by 
simply moving it to where ever you want it on the desktop (Edit Mode>Themes>Move/Resize). 

2    800x600 full screen with solid color background: you should be able to use it at a higher resolution, but 
you will have to: 
· change the background color to match your background; 
· move the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); 
· resize it downward to the right hand corner; and 
· reposition everything to where you want. 

3. 800x600 full screen with single graphic background (a 800x600 bmp or jpg): you will have to: 
· move the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); 
· resize it downward to the right hand corner (in the Object Editor, get the size of form0; you'll need that for the 
next step); 
· consider what you are going to do with the graphic: 
· delete it: use the Object Editor to delete it (Edit Mode>Object>Editor>form0, then delete in the graphics window);
· keep it as the background: when the theme is resized, the background will tile across the new size, if you like it 
tiled, leave it alone; otherwise use a screen capture application to capture it, then using your favorite graphics 
editor, crop it, resize it (probably won't work very well) or change the canvas size to the form0 size, do something 
with the new surrounding empty space, save it as a bitmap, then use the Object Editor to make it the background 
for form0; 
· keep it as a picture: when the theme is resized, the background will tile across the new size, if you like it tiled, 
leave it alone; otherwise use a screen capture application to capture it, then using your favorite graphics editor, 
crop it, save it as a bitmap, use the Object Editor to bring it back into the theme as a picture, and put it where you 
want it); or 
· change it: use the Object Editor to change it. 
· reposition everything to where you want. 

4. 800x600 full screen with a tiled graphic background: you should be able to use it by 
· moving the theme to the upper left hand corner where you want it to start (i.e., top=30, left=0); and 
· resize it downward to the right hand corner (the background will retile to the new size).



Using the Talisman RunTime Version
Question: I am the systems administrator for a small training company. I saw your program available on the 
internet and I purchased it to check it out to see if it's something that could be integrated into our systems. We run 
about 30 training workstations on Windows 98. We don't want people to have access to the recycle bin, task 
manager, control panel, explorer or quit. Basically making Talisman as the desktop for our entire computer. I was 
wondering if these features can be removed from the program. I also do graphic design and my boss wants me to 
make a custom desktop for her training environment. That is the reason I looked into Talisman in the first place. 
Although I haven't looked at the runtime version but I assume that's what we will have to get in order to implement 
this effectively. So if you could tell me if these things are possible please let me know. I was looking at the web site 
and I didn't see a runtime version available for english and a manual for Talisman ver. 1.1. I was just wondering if 
these were available or going to be soon.

Answer: You are correct. The RunTime version is what you need. Remember, though, you must have the full 
version to use the RunTime. TalismanRT has only all desktop features of Talisman without popup menu and 
everything it contains, such as the ObjectEditor or Button Wizard. Also your users will not have access to the 
Recycle Bin, Task Manager, Control Panel, or Explorer, as long as you do not make special buttons for them.




